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Introduction
Fractal Terrains 3 is ProFantasy’s fractal world-

generating program. FT3 lets you create maps using 

either fractal algorithms, real world data, or from 

scratch. FT3 includes height, climate temperature and 

rainfall information, all of which can be edited. You 

can view your maps in a variety of projections and 

color schemes and export any view to CC3. Export into 

JPEG, PNG, BMP, VRML, linked HTML, Spin View, and a 

variety of other formats. FT3 includes extensive Earth 

and Mars height data.

Using this Manual

This Essentials Guide gives you enough to get you 

started, without overwhelming you with details.

Items underlined in bold text are referring you to the 

side bar for definitions and additional information. 

Toolbar buttons, dialog box items and menu items are 

shown in bold text like this World Settings .

The FT3 Support Files

It is worthwhile exploring your FT3 directory beyond 

the program executable files. You will discover 

examples of worlds created with the software, as 

well as real-world data that can be used with FT3 to 

produce realistic maps based on the geography of 

Earth and Mars. 

If you register your FT at www.profantasy.com, you 

will get access to the Terraformer package which 

includes a large amount of additional support material, 

like new color schemes, climate textures and many 

cloud overlays. You might also want to check out 

latest version of Wilbur, a comprehensive fractal world 

generation tool. While FT3 is ideal for quick generation 

of worlds, shielding you somewhat from the fractal 

theory the software uses, Wilbur is an excellent tool for 

those wishing to explore this theory to even greater 

depth.

CC3

Throughout the text, 
you’ll see references to 
CC3. CC3 is ProFantasy 
Software’s map-making 
software. FT3 and CC3 
are designed to integrate 
closely. Even if you don’t 
use CC3, you might find 
it useful to download the 
CC3 viewer from
www.profantasy.com.

Toolbars

If you cannot locate a 
button, it will be because 
the toolbar to which the 
button belongs is not 
currently shown.

In order to display a 
required toolbar, click 
the View menu and click 
the name of the toolbar 
desired. Toolbars that 
are currently displayed 
appear on the menu with 
a tick next to them. If no 
tick appears, that toolbar 
is currently hidden.

Wilbur

You will find the latest 
version of the Wilbur 
software at
http://www.ridgecrest.
ca.us/~jslayton/software.
html.
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Tool Bars

FT3 uses standard Windows® floating toolbars.

Toolbar Purpose Buttons

World Tools Control files, create new 
worlds, change color schemes 
and settings.

Map Tools Control what you see.

Tool Palette Select areas, switch view 
between climate, altitude, 
temperature and rainfall. 
Paint in new values.

Climate 
Selector

When the Climate tool is 
active, choose which climate 
to paint in.

Information Windows

There are three additional floating windows in the FT3 interface, 

accessible through the View Menu, and these can be hidden, 

dragged, or placed within the main window just as toolbars are.

Globe 
Tool

This window contains a globe which can be rotated to 
adjust the current world view. Click and hold on the globe, 
and move the cursor to rotate it. The world view will pan 
accordingly when you release the globe.

Color Key This window keys the contour colors used for the current 
world. There are four versions of the color key window, one 
for each of the information views (Altitude, Climate, Rainfall, 
and Temperature).

View 
Properties

This window contains general information about the current 
world, or the portion of the world beneath the mouse cursor. 

Windows® is a registered trademark of the Microsoft Corporation.
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Tool Options

The Tool Options toolbar changes its content 

depending on what editing tool you have selected. 

It lets you change the size of the size of editing 

selections, the strength of an applied effect and so on.

Preferences

You can alter your interface preferences by selecting 

Preferences from the Edit menu. This presents the 

Preferences dialog box. The settings you choose here 

will depend partly on the speed of your PC. Change 

these settings and your window size until you are 

happy with FT3’s redraw speed.



5

Your First World
Double-click FT3 on your computer’s desktop. You will 

be presented with several windows that comprise FT3’s 

main screen. We recommend that you do not run FT3 

in a maximized window unless you have a fast PC.

Starting a Random World

On the 1. File menu click New. 

You see the Type dialog box.

For now, we shall create a synthetic world.

Ensure that the 2. Synthetic World radio button is 

checked, and click Next. 

World Settings

You see the 3. World Settings dialog box. 

Synthetic World

A • synthetic world is 
one created by FT3’s 
fractal functions.

A • binary world is one 
created from imported 
data.

A • flat world is a billiard 
ball, ready for you to 
edit yourself.

A • planar world is 
a synthetic world, 
mapped to a flat plane 
instead of a globe.

World Settings

You can also access this 
dialog to edit the current 
world by clicking on the 
World Settings  button 
and choosing the Primary 
tab.
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Highest Peak and Lowest Depth set the maximum 

and minimum altitudes for the world. Sometimes 

the generated world may exceed these values, but it 

usually keeps within these bounds.

The Circumference or Diameter (depending on the 

option selected from the drop list) is in current units.

The World Seed is the world number to generate. It sets 

the random number seed for the internal generators. 

Click on  to randomly allocate this value.

Method selects the way altitude will be computed. 

There are many different options available. Use the 

default Wilbur Ridged Multifractal for the time being, as 

it gives a good basis for a realistic-looking world. Come 

back later and play around with different methods to 

get different worlds.

Roughness controls the level of roughness in a surface. 

This value is roughly the fractal dimension of the 

surface. The sequence below shows how Roughness 

affects the surface from high (0.01) to low (1.49):

0.01 0.38 0.75 1.13 1.49

Percent Sea sets the rough amount of sea that will be 

found on the map.

Land Size sets the size of the land masses. The 

sequence below shows how the changing the setting 

changes the land mass size:

1.00 2.14 5.50 10.00

The smaller the land size setting, the more continents 

(or islands) you will get. A value of around 1.6 to 2.5 

usually provides good results.

Units

FT3 uses Imperial units 
by default, so this will 
be Miles. 

To change FT3’s units to 
kilometers, meters and 
degrees Celsius, click 
World Settings , 
choose the Secondary 
tab and select Metric 
Units.
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The three settings you want to concentrate on are 4. 

Roughness, Percent Sea, and Land Size. Try the 

following values:

Roughness: 0.75• 

Percent Sea: 50• 

Land Size: 2.44• 

Keep the other values the same.5. 

Click 6. Next and then Finished.

FT3 will spend a few moments calculating, and 

will then draw the world into the main screen.

Congratulations! You have just created your first world.

The Next Step

If you aren’t yet satisfied with the basics of the world, 

(proportion and size of land vs sea, height of peaks), 

you can edit the world settings to adjust them to your 

liking.

Click 7. World Settings  to adjust the parameters 

for your world as well as changing Secondary, 

Temperature and Rainfall settings.

On the 8. World Settings dialog choose the Editing 

tab to change the resolution used to depict 

your world. The higher the resolution, the more 

memory FT3 will need. For your first world and for 

exploring FT3’s functions we recommend sticking 

with the default editing setup.

The 9. Selection tab lets you save and load different 

world settings you are happy with and want to 

Secondary

These settings allow 
you to affect the way 
in which the world is 
calculated. You may 
also change climate 
coloration, the location 
of the northernmost 
pole, axis tilt, etc. 

If Continental Shelves are 
selected, the value on 
this line is the depth at 
which the shelves will be 
generated.

The North Pole Position 
group controls the 
location of the north 
pole. The change will not 
be applied to any terrain 
editing.

Temperature

Axis Tilt affects the 
temperature distribution 
of the world. 

The Planetary 
Temperature Model 
group controls the 
settings the general 
temperature setup of 
your world.

Rainfall

Base Value controls the 
average rainfall, and 
Random Amount the 
variation.
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reuse at a later time. Under Fractal Function you 

can change the underlying mathematical function 

used to create the random world.

Click 10. Apply to apply any changes you made in 

the World Settings to the current world.

Color Settings

Click 11. World Coloring  and you see the Lighting 

and Color dialog box:

Choose the 12. Select Coloring Scheme tab.

Select a suitable color scheme for your altitudes 13. 

and then Load and Apply to apply it to the 

current world.

If you want to edit the colors of a scheme, click 14. 

the Altitude tab. 

You can change the colors used for the land 

height and sea depth contours by clicking on the 

World Coloring

If the Blended check 
boxes on the Altitude tab 
are set, FT3 will draw the 
contour colors so that 
the transition between 
one contour and the 
next flows smoothly. 

While this produces a 
more realistic look, it 
can slow down world 
redraws.

If the land Shaded 
check box is set, FT3 
will calculate and draw 
shaded highlights to 
raised terrain features.

As with blending, 
shading can slow down 
redraw times, but will 
produce a more realistic 
effect.

The sea Shading check 
box is used to tell FT3 
whether to draw similar 
shading for sea depth 
contours. 

This check box will not 
be available if the land 
Shaded check box is not 
checked.
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color boxes. 

You can save your choices to a 

scheme for use in other worlds of 

your creation.

The 15. Rainfall, Climate and 

Temperature colors can be 

changed in the same way.

Click the 16. Intensity tab.

You see the Light direction and 

Shadow settings:

This is used to define how contour 

shading will appear for your world.  

You can set the vertical (Elevation) 

and horizontal (Azimuth) angle at 

which light will appear to strike 

your world, as well as the intensity 

of the shading that will be used.

Change the angle and click 17. Apply 

to change the lighting of your 

world.

When you are happy with the basic world settings, 

click Next World  a few times to cycle through 

various world layouts — this simply changes the 

random seed, but leaves all other settings intact.

Continue cycling through worlds until you find one that 

is suitable for your purposes. It’s much quicker to find a 

random world you like than to edit one you don’t.
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Navigating the World
FT3 possesses functionality allowing you to move 

about your world, and to zoom into and out of areas 

within it. It is a good idea to become familiar with 

these various functions, as they will be useful when 

you come to edit and otherwise play with your new 

creation.

Moving Around Using the Globe

The small globe can be rotated to achieve the view you 

desire. To pan your world using the globe:

Move the mouse over the globe, so the cursor 1. 

becomes a hand, then click (do not release).

The mouse pointer will appear to “grab”.

Move the mouse.2. 

The globe will rotate with the mouse.

When the area you want to view is in the center 3. 

of the globe, release the mouse button.

FT3 will re-draw the world to show the new view. 

The “closest” point to you on the globe is now at 

the center of the view window.

Zooming In and Out

You can also use the Zoom buttons to change the view 

on your world.

Moving Around Using the Main Map

As well as using the Globe, you can move the current 

view by panning around the map. If the map window is 

large, this may be slow.

Click 1. Pan .

The mouse pointer will become a hand.

Click and hold the mouse button down within 2. 

the world view. The mouse pointer will appear to 

“grab”.

Move the mouse through the desired pan 3. 

Zoom Buttons

Click Zoom In  to 
change the view so that 
it is zoomed in by a 
factor of two. 

Click Zoom Out  to 
change the view so that 
it is zoomed out by a 
factor of two.

Click Zoom Extents  
to change the view so 
that the entire world 
fits within the display 
window.

Click Zoom Window 

, then click a point, 
move the mouse and 
click another point 
forming a box. The view 
will change to show a 
zoomed view of the area 
within that box.
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distance and direction, then release the mouse 

button. FT3 moves the map within the view 

window to show you the new view area.

Alternatively you can hold down SHIFT while 4. 

using the pan tool. This rotates the world as if in 

Globe view, rather than simply moving the map 

area in the view window.  This is easier to see 

than explain, so Zoom Extents then try SHIFT-

panning.

Map Projections

Displaying a 3D globe 

on a flat surface poses a 

problem. Over the years, 

several different methods 

of achieving this have been 

devised. Such methods 

produce flat-map views, or 

projections, of the globe. FT3 

can display your world using 

many projection methods.

Click 1. Change Projection  . 

You see the Map Projection dialog box.

Click one of the listed map projections.2. 

The preview of the world will change to reflect 

the selected projection. We recommend the 

Equirectangular projection as the best all-round 

option.

Named Views

You can create named views for your world. When 

a named view is created, map projection, scale, and 

position are stored within it. Named views can be used 

for world navigation and to export sections of worlds.

They are especially useful for outputting consistent 

images of the same portions of a world using different 

settings and during different FT3 sessions.

Right-click within FT3’s main screen.1. 

Map Projection 
Dialog Box 

The Map Projection 
dialog has three basic 
sets of parameters:

Projection Center, 
represented by the values 
Lat (latitude) and Lon 
(longitude), defines the 
central point for the 
projection display.

View Offset (represented 
by X Ofs and Y Ofs) 
defines the offset from 
the projection center to 
the center of the area 
of interest. View Offsets 
can be used to center 
a view to a particular 
latitude and longitude 
coordinate.

Scale is expressed as a 
zoom ratio, eg a Scale of 
1 will display the entire 
world, 0.5 will zoom in 
by a factor of ×2, 4 will 
zoom out by a factor of 
×1/4, and so on.
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You see the Context menu.

Click 2. Add View.

Enter a name for your view, then click 3. OK.

If you intend to export saved views (see Help: 

Saving and Restoring Views), it is advisable to use 

legal Windows® file names.

Click Show 4. View Window on the context menu to 

open the View Management dialog box:

Click one of the listed views then 5. Show to use it.

Multiple named views can be selected by holding 

down CTRL while clicking to select, and selecting  

names individually, or holding down SHIFT to 

select a range of view names.

Viewing World Information

As well as altitudes, FT3 will automatically generate a 

world’s climate, temperature, and rainfall, as well as its 

general geography. While these calculations are based 

more on theory than any “true to life” scenario, they 

can be edited.

Click 1. Show Altitudes  to show your world’s 

height contours and general geography (this is 

the current view).

Click 2. Show Climate  to show the climate zones 

FT3 has calculated for your world.

Click 3. Show Temperature  to show the 

temperature zones FT3 has calculated for your 

world.

Click 4. Show Rainfall  to show the precipitation 

levels FT3 has calculated for your world.

Context Menu

The Context menu 
provides a quick mouse 
shortcut to some of the 
more commonly used 
commands. You can 
use it, by  right-clicking, 
instead of using the 
standard menu and 
buttons to access these 
commands.

View Management

As well as adding and 
showing views, you can 
export them.

Export As CC3 exports 
the currently  selected 
named views as CC3 
and/or JPEG files.

Current Views

For each view, 
different colors are 
used to indicate the 
different values FT3 has 
calculated. The colors 
and their associated 
values are shown within 
the Color Key window. 
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Adding a Grid

FT3 has the capability of adding gridlines to your map. 

Since grids are based upon longitude and latitude, the 

manner in which a grid is displayed will depend upon 

the current projection used.

Click 1. Grid Settings . 

You will see the Grid Settings dialog box:

Click 2. Add to create a new grid in the list.

Check 3. Enable Grid in the Grid settings dialog that 

comes up.

Click the 4. Color of the grid then choose a color and 

click OK.

Change the 5. Longitude and Latitude Spacing 

values for the grid. It is normal to set larger grids 

as multiples of any underlying grids. Try 30 for 

the main  grid. Click Ok.

Add 6. any secondary grids in the same manner, try 

a 10° grid in a lighter color.

Move the 7. Subdivision Level slider bar so that the 

setting reads 2 Divisions. 

Latitude Polar Endcaps 8. defines the area where 

the horizontal grid will not be shown near the 

poles. This is useful for projections where the 

converging lines would otherwise obscure too 

much of the map. Leave it as it is and click OK.

Gridlines

You can define any 
number of separate 
grids. This is useful for 
example when you 
wish to depict minor 
and major grids (eg a 
dark grid line every 15 
degrees, and a light grid 
line every 5 degrees).
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The View Properties window

This window contains general information about the 

current world, or the portion of the world beneath the 

mouse cursor. It gives you an idea of maximum and 

minimum values on the world, as well as assisting in 

choosing suitable areas to export.

Distance Measurement

You can also measure linear distances across the 

world. Click Distance  and then click both ends of 

the linear distance you wish to measure. FT3 will report 

the measurement.
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Editing your World
FT3 does not stop once your world has been created. 

Perhaps the mountains are too high, the seas too deep, 

or there is something else that you wish you could 

change to make your world just so. To this end, FT3 

provides a number of editing tools that can be used to 

tweak your world.

The Editing Tools

FT3 possesses eleven editing tools, all of which are 

available via the Tool Palette. Each tool affects a 

painted area. You can change the size of the current 

tool. Press SHIFT and click to perform a global change.

So that you see the results of your editing, we 1. 

recommend you choose a suitable Show... button 

first (eg Show Climate when you use Warmer and 

Colder).

Click the button representing the editing function 2. 

you wish to use.

Move the mouse to the region you wish to edit 3. 

within your world.

Click and hold the mouse button down. 4. 

Move the mouse across the area you wish to edit.5. 

Your edit will be “painted” onto the world as you 

move the cursor. Since FT3 needs to calculate 

edits in order to apply them, it is a good idea to 

move the mouse slowly to ensure that the edit is 

applied to the whole region desired.

 Once you have painted all of the desired area, 6. 

release the mouse button.

Editing tools only affect the current selection. If you 

haven’t selected any particular region of your map, 

then the tool will affect any area it touches. For more 

on selection, see Selection Functions on page 16.

Editing Tools

Raise  and Lower  
affect the altitude.

Raise  and Lower 

Prescale Offset  
are advanced editing 
functions for greater 
precision in editing 
continental shelves and 
will not be discussed 
here.

Rougher  

and Smoother  
increase and decrease 
the height variation.

Wetter  and Drier  
affect the level of rainfall. 

Warmer  and 

Colder  affect the 
temperature.

Water level  causes 
a brushed area to be 
represented as water, as 
long as its height is lower 
than the current brush 
setting.
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Changing the Editing Tools

You can set the extent to which edits are applied in 

the Tool Options window (at the bottom of the screen 

by default). It will rename itself to Paintbrush Options 

when an editing tool is selected and show the current 

size, strength (Value) and type of the selected editing 

tool. The values you enter can be saved as presets for 

future use.

Climate Painting

Paint Climate  is used to change the climate settings 

for an area painted. To use this tool, you must first 

select the type of climate you wish to paint from the 

Climate Selector toolbar. Fifteen climate types are 

available.

Selection Functions

FT3 provides a number of selection tools which can 

be used to mask portions of a world. When a selection 

mask is applied, all edits will only affect currently 

selected portions of a world. Global edits will be 

applied to all areas within the selection, and areas 

outside the selection will remain untouched.

Basic Selection Functions

Four basic functions are accessed from the Select 

menu. These are:

All•  selects the entire world.

Deselect•  deselects all current selections.

Reselect•  restores the last selection after a Deselect.

Inverse•  inverts the current selection, so that 

everything currently selected is now de-selected, 

and vice versa.

Selection Tools

Four tools are provided which allow selection by shape. 

These tools can be found in the Select menu and on the 

Values

Note that the editing 
tools may have no 
discernible effect when 
using low tool settings 
values at  high zoom 
levels.

Selection by Shape

Select Rectangle 

Select Ellipse 

Click to place the first 
corner, move the mouse, 
then click again to place 
the opposite corner.

Select Freehand 

to manually draw a 
selection mask. Click to 
start the selection, draw 
the required selection by 
moving the mouse, click 
to complete.

Select Polygon 

Click to start the 
selection, then click to 
place further points as 
desired. To complete the 
selection, either triple-
click (effectively clicking 
once to place the final 
point, then double-
clicking in the same 
location to complete), or 
press ENTER.
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Tools toolbar. 

These selection tools can also be used to add to or 

subtract from the current selection. Holding down 

SHIFT when completing the selection will add the area 

to the current selection, and holding down CTRL will 

remove the area drawn from the current selection.

Range Selection Functions

The Select menu provides four range selection 

functions that are used to select portions of the world 

that conform to given parameters. These tools prompt 

for the range or climate type required via a dialog box. 

Selection Mask Modification

The current selection mask can be further modified.

Binarize will “harden” the selection, so that each pixel is 

either fully selected or fully deselected.

Feather will “soften” the selection mask, blurring it 

around the edges. You will be prompted to enter the 

amount by which the selection is to be smoothed. 

Feathered selections can have partially-selected pixels.

Modify >> Border will create a strip of selection along 

the current selection’s border. You will be prompted for 

the width of this strip.

Modify >> Expand will increase the size of the current 

selection by one pixel in all directions.

Modify >> Distance converts the selection into 

distances from the edge of the selection.  

Modify >> Contract will decrease the size of the 

current selection by one pixel in all directions.

Selection Mask Files

You can save selections for use in the future as a 

selection mask file.

Save Selection will save the current selection as a 

Range Selection

Altitude Range selects 
by altitude, in feet (or 
meters).

Temperature Range 
selects by temperature, 
in °F (or °C).

Rainfall Range selects by 
rainfall, in inches per year 
(or cm).

Selecting by Climate 
Range always replaces 
the current selection. This 
opens a dialog box which 
lists all of the climates 
FT3 recognizes. Check 
boxes to the left of the 
listed climates to include 
them in the selection.
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bitmap file.

Load Selection will prompt for the selection mask file 

to use, and will then apply that to the current world.

Mounds

The Tools >> Actions >> Mound function takes 

parameters you provide, then adjusts the altitude 

values within a selection accordingly. It is useful for 

creating mountains, plateaus, etc.

The Moundtain tool is similar to Mound, but uses a 

very different algorithm to achieve its effect. This tool 

creates a mound, shrinks the selection, creates another 

mound, and continues until the selection is completely 

used. Use of this tool will destroy your current 

selection.

The Profiled Mound tool is again similar to Mound, but 

it has additional options, primarily the ability to specify 

a profile on the mound rather than a simple operation.

Adding Rivers
The Find Rivers tool in FT3 computes the directions and 

amounts of water flow in the world and then places 

rivers over the areas of highest flow. Once a set of 

rivers has been computed, these rivers will be stored 

internally as vectors. 

The vector river overlay may be shown and hidden by 

toggling the Tools >> Rivers >> Show River Overlay 

option. It may be removed entirely by using Clear River 

Overlay.

Calculation Resolution

Although FT3 can calculate your world altitudes to a 

very high resolution, it cannot run rivers at those same 

resolutions due to space and time constraints. The 

River Definition Resolution dialog allows you to select 

the desired output resolution of the rivers.

Mound

Min (ft): is the value that 
will be applied to the 
edge of the selection, in 
feet (or meters).

Max (ft): is the value that 
will be applied to the 
center of the selection, in 
feet (or meters).

If Replace Offset is 
checked, the current 
values of the selection 
will be replaced by the 
Mound function. If 
unchecked, the Mound 
function will add to the 
current values.

Gamma indicates the 
linearity of the mound’s 
slope. A value of 1.0 will 
produce a mound with 
fairly shallow-sloping 
sides. Values less than 
1.0 will provide flatter 
tops and steeper sides. 
Values greater than 1.0 
will produce shallower 
sides and more pointed 
center ridges.

Highest Flow

Due to the way the 
process is defined, a river 
will stop flowing when it 
hits water, so a small lake 
can absorb the entire 
output of a large river. 
In that case, it’s best to 
fill in the small lake and 
rerun the rivers tool.
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Rivers will run slightly differently depending on the 

chosen resolution. The image below shows an example 

of this difference for each of the default resolutions:

Vector Rivers

After the initial computations, the system will display 

the window below to let you finalize the river settings:

If you have a slower computer or very limited memory 

resources then the river process can take a very long 

time. Pressing Cancel on the progress dialog will stop 

the attempts to route rivers. Stopping the computation 

will reduce the number of river segments computed. 

Reduce the computation resolution and try again.

River Settings

The River Length slider 
controls the length of 
rivers appearing on the 
map.

The Color block controls 
the color of the inserted 
rivers.

The Potential River 
Flow checkbox controls 
whether to use FT3’s 
rainfall model to 
compute river flow (if 
unchecked) or whether 
to use a constant rainfall 
at every world point (if 
checked). 

Potential river flow can 
give longer or shorter 
rivers in various parts of 
the world depending on 
local rainfall conditions.

The Keep River Image 
Overlay checkbox 
indicates if the onscreen 
image overlay shown in 
this stage will be kept as 
part of the world. The 
raster image overlay will 
be discarded and only 
vector information will 
be kept if this box is 
unchecked.
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Flat Worlds
If you want to manually draw land patterns, rather 

than allowing FT3 to randomly generate them for 

you, you can create a new world that possesses a flat, 

featureless terrain.

Using a flat world as a starting point, you can then use 

the editing tools to paint terrain features as you wish.

To start a new flat world:

On the 1. File menu, click New.

You see the Select World Type dialog box.

Check the 2. Flat World radio button then click Next.

You see the 

Synthetic World 

dialog box.

Set desired options, 3. 

particularly the 

Circumference 

and expected 

maximum heights 

and depths.

Steps 3 is 

performed in exactly the same way as for 

synthetic worlds. See the chapter Your First 

World.

From the Synthetic World dialog, click 4. Next.

FT3 shows a note on creating flat worlds.

Click 5. Finish to generate the world.

FT3 displays the flat world. The altitude is 0 feet 

(sea level) all over, and therefore normally shown 

blue.

On the 6. Tools menu, click Global Set >> Altitude, 

type 100 and press OK.  FT3 raises the height all 

over the globe, and will therefore now appear 

plain green.

The world may now be edited as you see fit using FT3’s 

editing tools.

Synthetic World dialog 
Box

Flat worlds use the same 
underlying setup as do 
synthetic worlds.

Raise the Height

Because of the way the 
raise and lower tools 
work, it’s better to start 
with a raised surface 
and use the lower tools 
to make seas than vice 
versa.
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Worlds from Real World Data
As well as being able to create worlds from scratch, 

FT3 has the ability to import binary data files that 

define sections of terrain. You will find examples of 

such files, from the GTOPO30 real-world data sets, 

that you can import into FT3 to produce maps based on 

planetary data.

Creating a World

Click 1. New.

You see the Select World Type dialog box.

Pick the 2. Binary File radio button, then click Next.

Click 3. Choose 

Elevation File.

You see the Binary 

Data dialog box.

Click 4.  to select 

the required file 

from a file dialog 

box. Select the file 

ETOPO5.bin in the 

Terrain Data folder.

FT3 automatically finds the header file for the 

data and prompts you whether to use it. Click 

Yes. The header file sets the remaining values in 

the dialog box.

Press 5. OK to return to the Binary Data wizard. 

Click 6. Next and then Finished to start the world 

generation. 

FT3 displays 

the map in 

the main 

window. 

Import Binary Data

Note that the binary file 
used must be present 
for as long as you intend 
to use the world file. 
FT3 does not import 
the binary data into its 
own format, but rather 
uses the binary file for 
reference. 

Moving or deleting the 
binary file after saving 
a world created with it 
will result in the world 
file being unusable. This 
can be avoided by using 
the Burn In To Surface 
function, which is further 
detailed below.

Required File

The real-world data 
that comes with FT3 is 
found in the Terrain Data 
directory under your FT3 
program folder.

ETOPO5 is low-resolution 
altitude data of the 
whole word.

Mola2x2a is altitude data 
of Mars.

USTOPO30 is hi-
resolution altitude data 
of the United States only.

GOTOPO30 is hi-
resolution data of the 
complete Earth globe. 

The GOTOPO30 data 
set is too large to 
be distributed in an 
unzipped format. Unzip 
it to a location of your 
choice before using it.
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Burn In to Surface

This function takes the current world information, and 

includes the data directly in the current FT3 drawing. 

This removes FT3’s reliance on binary data files; in 

effect, the binary data is converted into FT3’s native 

format.

Once the Burn In to Surface function has been used, it 

cannot be undone.

To use the Burn In to Surface function, select Burn In to 

Surface from the Tools >> Actions menu. 

The images below show what can happen with the 

burn operation at differing editing resolutions.

Notice how the fine details are lost at small resolution 

(on the right).

FT3’s Native Format

As a side effect, the Burn 
In to Surface function 
removes the contribution 
of the fractal basis 
function, resulting in 
a smoother map. This 
makes the function 
useful for worlds that do 
not use binary files.

Burned files are much 
bigger than raw, 
unedited FT3 files.
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Exporting and Importing
Once you have edited your world so that everything 

matches your desires, you may wish to export it to an 

image file, a CC3 file, a series of image or CC3 files, or 

even to a Virtual Reality Modeling Language model.

File Formats

The BMP, JPEG, PNG, Wilbur (MDR) and RAW formats 

all save the current view (not the whole map) as either 

a color map or as a height field readable by Wilbur. 

These formats have limits on the size of an image that 

can be saved.

The Special MDR format, on the other hand, has no 

limit on the size of the output image and always 

outputs its information using a simple Equirectangular 

projection. This format is very useful when exporting 

a high resolution image from FT3 to use as a binary 

image within FT3 or as an input file within Wilbur.

All these file formats are available from the File >> 

Save As dialog.

Exporting to Campaign Cartographer 3

CC3 is a powerful cartography tool that can be used to 

further enhance and manipulate your world.

Before you can use it, you must first export the world 

to one or more CC3 map files (FCW). You can do so via 

the Save Campaign Cartographer 3 File option in the 

File menu, via the Export As CC3 function of the View 

Window, or as multiple, hyperlinked files from File >> 

Export Worlds >> Multiple Files.

Whenever you export views from FT3 to CC3, you need 

to choose a setting for export, or create one of your 

own. See the FT3 help files for more information in 

creating and editing your own CC3 export settings.

To export the current view in the main window to 

CC3...

Export

FT3’s native file format is 
FTW. You should always 
save your world in FT3’s 
own format, especially if 
you intend to use FT3 to 
further edit and refine it. 
FT3 also supports:

Bitmap image format • 
(BMP)

JPEG image format • 
(JPG)

PNG image format • 
(PNG) in color and 16-
bit greyscale variations.

Wilbur format (MDR)• 

Special MDR (MDR)• 

Raw data binary format • 
(RAW).

Views

All CC3 export funcitons 
save the current view of 
the map, not the world 
world. 

Thus, to produce a CC3 
map covering a small 
area of your world, 
just zoom into the area 
required. To ensure that 
the same view can be 
exported during different 
FT3 sessions, use the 
Named View features 
available from the View 
Window in the View 
menu.
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Click 1. File >> Save Campaign Cartographer File...

The available export settings files will appear in 

the list.

Choose an export setting — 2. Basic 100 Contours is 

a good one to start with.

Click 3. Export World.

Save the file to a location of your choice and 4. 

open it in Campaign Cartographer 3.

Exporting to Multiple CC3 Files

FT3 can output your world to several CC3 files, each 

comprising a smaller, tiled section of the map. It is 

often useful to do this, since attempting to depict a 

detailed world map within a single CC3 drawing can 

result in an unamanageably huge file. 

The Map Level Info settings determine how the world 

will be divided into multiple files. Each map level set 

will comprise a number of files that tile together to 

form the whole world. For example, if two map levels 

are chosen, you will have two separate sets of CC3 (or 

JPEG) files, each slicing up the world map into a number 

of tiles at a different scale. 

To export your world to several CC3 files:

Select 1. File menu >> Export World >> Multiple 

Files.

Check the 2. Generate FCW Files option and select 

a setting from 

list of available 

ones.

Choose 3. 

suitable 

settings for the 

other controls.

To choose a 4. 

location for 

the output 

files, click the 

Settings

Generate HTML creates 
HTML files linked to the 
JPEG files (if any).

The Map Levels option 
is used to determine the  
number of image sets 
that will be created.

Files Wide: The number 
of files used to depict the 
world’s horizontal axis at 
this level.

Files High: The number 
of files used to depict the 
world’s vertical axis at 
this level.

Percentage Overlap: The 
extent to which each file 
of a given level overlaps 
with those adjacent to it.

Image Resolution lets 
you specifiy the width (in 
pixels) of the generated 
jpg files.

FCW Links puts links on 
any generated HTML 
pages to the  matching 
CC3 files.

Activating Per-level FCW 
lets you specify the CC3 
export settings separately 
for each level.
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directory selection button .

The files will have a filename consisting of a 

letter and a number. The letter refers to the map 

level (the overview map will be “A”, level one will 

be “B”, and so on). The number refers to the row 

and column of the map’s tile.

Exporting an Icosahedral Projection

Icosahedral projections are commonly used to depict 

worlds within science fiction roleplaying games such 

as Traveller®. Basically, an icosahedral projection takes 

the form of a flat-view exploded 20-sided shape.

To save your world as an icosahedral projection:

Select 1. File >> Export World >> Icosahedral.

You will see the icosahedral Save As dialog box.

Change the 2. Width value if desired. The higher the 

Width setting, the larger the output file will be.

Click the 3. Background Color button.

Choose the color you wish to use for the output 

file’s background and click on OK.

Type a name for the file in the 4. File Name box.

Select the desired 5. file format from the drop-list.

Click 6. Save. 

FT3 creates the icosahedral image file.

Exporting to a Cosmographer Template

This export function creates an icosahedral projection 

File Format

Bitmap, JPEG and PNG 
formats are available for 
icosahedral export.

Isocahedral

This icosahedral 
projection is a simple 
linear transformation of 
an equirectangular map.

Cosmographer 3

Cosmographer 3 is the 
science-fiction add-on 
to CC3 and this export 
is set up to facilitate 
further work within that 
environment. 
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PNG bitmap and embeds it in a Cosmographer 3 

template.  

Select 1. File >> Export World >> Cosmographer 

Template.

You will see the matching Save As dialog box.

Change the 2. Width value if desired. The higher the 

Width setting, the larger the bitmap output will 

be.

Click 3. Background Color button.

Choose the color you wish to use for the output 

file’s background and click on OK.

Type a name for the file in the 4. File Name box.

Click 5. Save. 

FT3 creates the icosahedral PNG image, the FCW 

file, and embeds the former into the latter.

Exporting a Spin View

A spin view is a series of image files that depict the 

globe over a period of rotation. These files may be then 

combined in a third party application to form a rotating 

globe animation.

Select 1. File >> Export World >> Spin View Image 

Sequence.

You will see the Save Spin View Sequence Files 

dialog box.

Set up the 2. export parameters as desired.

Type a name for the file in the 3. File Name box.

Select the desired file format from the drop-list.4. 

Bitmap, PNG and JPEG formats are available for 

spin view export.

Click 5. Save.

FT3 creates the spin view image files. Each file 

will consist of the selected filename, plus a 

numerical suffix indicating where in the rotational 

sequence the file occurs.

Export Parameters

Size: The size of each 
frame in pixels.

# Frames: The number 
of images that will be 
created. If used for 
animation, the higher 
this value is the smoother 
the resultant animation 
will be.

Latitude: The degree of 
latitude that will form 
the center point of the 
rotational view.

Appear to be Shaded: 
Check this box if you  
wish the world to appear 
shaded.
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Exporting to VRML

VRML (Virtual Reality Modeling Language) 

is a modeling language that can be used 

to depict interactive 3D objects and 

environments. To use a VRML file, you will 

need a viewer capable of understanding 

the language (there are many such viewers 

available, including plug-ins for Internet 

browsers).

Select 1. File >> Export World >> VRML.

Set the desired width for the output file.2. 

Type a name for the file in the 3. File 

Name box.

Click 4. Save.

FT3 creates the VRML file. To view the file, open 

it with a VRML viewer.

Exporting to Google Earth (KMZ)

KMZ is the file format used by Google Earth®. 

Exporting to it creates a file that you can view in 

Google Earth®, enabling that program’s powerful 

display features and its ability to add locations, 

landmarks, overlays and so on. 

Select1.  File >> Export World >> KMZ File...

The Save As dialog comes up, 

Specify the output 2. Width (in pixels), a World 

Name and a short World Description.

Save the file by clicking 3. Ok.

Start up Google Earth4. ® and load the KMZ file in 

there. 

Exporting to Bryce2 and Bryce3D

FT3 does not directly support map exports to Bryce2 or 

Bryce3D formats. However, Wilbur does. It is therefore 

possible to export a map from FT3 to Wilbur (use MDR), 

and then use Wilbur to export the results to Bryce.

Google Earth®

Google Earth® 
is a free-to-use 
software available for 
download at 
www.google.com/
earth.

It is mainly a viewer 
for Earth satellite 
imagery, maps and 
lots of additional 
data, but can also 
be used to overlay 
custom images over 
the globe. 
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Importing Images and Creating Overlays

FT3 supports an arbitrary number of image overlays 

that can be used to show information and external 

images. Basic drawing tools are provided to draw 

information directly on these overlays in FT3, but the 

more common usage is to import external bitmap files 

to show in FT3. As the overlays support transparency, 

lots of different things can be overlaid on the FT3 

world.

To add an image overlay 

in FT3:

Select 1. Image 

Overlays >> Show 

Overlay Window.

The Image Overlay 

window comes up.

Click 2. Add to add a 

new overlay and 

bring up the Edit Image 

Overlay window.

Choose suitable 3. 

parameters for your 

overlay.

To import a color image or 4. 

opacity map, click one of 

the two Import buttons at 

the bottom. 

Example Cloud Overlay

Use 1. Image Overlays>>Show Overlay Window to 

show the Image Overlays window

Click 2. Add to add a new overlay, call it Clouds and 

close it, leaving all other parameters untouched.

Select 3. Clouds in the list and click Set Active to 

make the new overlay the active one.

Click 4. Ok to close the Overlay Window.

Parameters

Visible indicates if the 
overlay can be seen.

Name is the name of 
the overlay shown in the 
Image Overlay window.

The Show drop-down 
list indicates what parts 
of the overlay should be 
shown. 

The options are Always, 
which always shows 
all parts of the overlay; 
Land, which shows 
only the portions of the 
overlay above water 
level; Sea, which shows 
the overlay only below 
water level; and the two 
Altitude Range options 
which allow you to set 
specific rangeson the 
map in the settings 
below.

The Opacity slider 
controls the transparency 
of the overlay.

The Size group (Width 
and Height) controls 
the editing resolution of 
the overlay, which is the 
fineness of the details 
allowed.

The Overlay World Edges 
group controls where on 
the world the overlay is 
placed.
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Use 5. Image Overlays >> Set Overlay Drawing 

Color to bring up the color picker.

Pick white (color 15) and click 6. OK.

Use 7. Select >> All to select the whole world.

Use 8. Image Overlays >> Fill Selection With 

Drawing Color to fill the overlay with solid white.

Use 9. Image Overlays>>Show Overlay Window to 

show the Image Overlays window again.

Double-click the overlay in the Image Overlays 10. 

window to bring up the Edit Image Overlays 

dialog.

Click 11. Import Opacity Image and load the clouds.

jpg image from FT3’s Example folder.

This bitmap will be converted to grayscale and 

resized to fit the image before being used as the 

transparency channel of the overlay.

Click 12. OK to accept the new transparency data.

You now have a beautiful cloud overlay on your world.
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Further Reading
The Essentials Guide cannot cover all the possibilities 

that Fractal Terrains has to offer, the variety of 

advanced features is just too large. But there are quite 

a number of other resources available:

Check out the pdf document • FT Pro Details in the 

Documentation folder of the FT3 program directory.

It has a detailed section on creating new map 

projections and writing scripts in FT3, among other 

things.

See Joe Slayton’s extensive tutorial on world-creation • 

in Fractal Terrains:

http://www.ridgenet.net/~jslayton/CGTutorial/

Follow Joseph Sweeney’s video tutorial on using • 

Fractal Terrains in conjunction with CC3:

http://www.youtube.com/watch?v=aJ1LlxnrElA

Make sure to register FT3 at www.profantasy.com • 

and download the Terraformer package for FT3.

Bibliography

Some books that also can help in the understanding of 

map projections are:

An Album of Map Projections•  (Snyder and Voxland; 

US Geologic Survey Professional Paper 1453)

Map Projections — A Reference Manual • 

(Bugayevskiy and Snyder; ISBN 07484 0304 3)

Flattening the Earth•  (Snyder; ISBN 0-226-76747-7)

The Album is out of print, but the others are readily 

available.

Terraformer

Created by Fractal 
Terrains expert 
Bill Roach, the 
Terraformer package 
has loads of useful 
files for your FT3, 
such as new color 
schemes, climate 
textures and cloud 
overlays.

Be sure to read the 
Terraformer User 
Manual included in 
the zip file.
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FT3 Examples

This is equirectangular projection view of real-world satellite data (GTOPO30) 
with a high-contrast color-scheme and a cloud overlay. 

This is a snapshot of 
a spin view export 
of a synthetic world 
with textured climate 
shader and cloud 
overlay.
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This screenshot 
shows a single 
continent from a 
high-roughness 
synthetic world, 
displayed with the 
Gaia shader.

FT3 calculates river 
flows along the 
worlds altitude 
gradients. 

The encircled island 
was added manually 
with the Raise tool.


